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Introduction
This User's Guide uses the following symbols to indicate important information.  Always observe the
instructions indicated by these symbols.

Indicates instructions that, if ignored, could result in death or serious personal injury
caused by incorrect operation of the equipment.
Instructions indicated by this symbol must be observed for safe operation.

Indicates instructions that, if ignored, could result in personal injury or material dam-
age caused by incorrect operation of the equipment.
Instructions indicated by this symbol must be observed for safe operation.

Indicates prohibited actions that, inadvertently performed, could result in equipment
damage, faults or impaired product quality.
Actions indicated by this symbol must be avoided for correct operation.

Indicates useful reference information or supplementary instructions concerning oper-
ation of the equipment.
Reading these notes is recommended.

Indicates information for Windows 98 and Windows 95 users only.

Indicates information for iMac and Power Macintosh G3 users only.

International ENERGY STAR® Program
AS AN ENERGY STAR PARTNER, CANON INC. HAS DETERMINED THAT THIS PRODUCT
MEETS THE ENERGY STAR GUIDELINES FOR ENERGY EFFICIENCY.

The international ENERGY STAR Office Equipment Program is a global program that promotes
energy saving through the use of computers and other office equipment.  The program backs
the development and dissemination of products with functions that effectively reduce energy
consumption.  It is an open system in which business proprietors can participate voluntarily.
The targeted products are office equipment such as computers, monitors, printers, facsimiles
and copiers.  Their standards and logos are uniform among participating nations.

Trademark Notices
• Canon® is a registered trademark of Canon Inc.
• BJ™ and BJC™ are trademarks of Canon Inc.
• MS-DOS®, Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the U.S. and

other countries.
• Apple™, Macintosh™, iMac™ and Power Macintosh™ are trademarks of Apple Computer, Inc. in the U.S. and other

countries.
• All other trademarks and registered trademarks appearing in this User's Guide are the property of their respective owners.
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About the Manuals

■ This User's Guide primarily describes the basic operation procedures for Windows (Windows 98, Windows 95
and Windows NT 4.0) users and Macintosh (iMac and Power Macintosh G3) users.
In addition to the User's Guide, the following manuals are also provided.

- Reference Guide (CD-ROM):
Describes detailed operation procedures of the printer for Windows and Macintosh users.

- Driver and Utility Guide for Windows Users (CD-ROM):
Describes how to use the printer driver, scanner driver and scanner utility program primarily for
Windows 98 and Windows 95 users. (For Windows NT users, a document file (NT_Guide320.doc) is
provided in the printer driver.)

- Driver and Utility Guide for Macintosh Users (book):
Describes how to use the printer driver, scanner driver and scanner utility program for Macintosh
users.

If necessary, you can also refer to the on-line Help to learn more about software such as the printer driver.

■ In these manuals, the Microsoft Windows 98 operating system, Microsoft Windows 95 operating system and
Microsoft Windows NT 4.0 operating system are referred to as Windows 98, Windows 95 and Windows NT
respectively.

■ Every care has been taken in the preparation of the manuals, but if you should discover any errors or omis-
sions, we would be pleased to hear of them.  If any error or omission is found, contact the manufacturer.
Refer to the Contact List provided with the printer for your nearest Canon office.

■ The manufacturer and its subsidiaries assume no responsibility for any results of operation of the product.

Software Operation
The manufacturer and its subsidiaries will assume no responsibility whatsoever for the effects of using this
manual or the associated software.
Unless specifically stated, nothing in this manual constitutes an intellectual property licence in respect of
the use of such software.

Copyright© 1999 CANON INC.
All rights reserved.  No part of this publication may be transmitted or copied in any form whatsoever without the express written
permission.
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For Windows 95 and Windows NT 4.0 Users
The screen shots in this User's Guide show the screen displays for Windows 98.
• If you are a Windows 95 user, the screen displays are almost identical and the operation proce-

dures can be used in precisely the same way.
• If you are a Windows NT 4.0 user, please note that some of the operation procedures are differ-

ent.  For more details, please refer to the "NT_Guide320.doc" document file provided with the
printer driver for Windows NT 4.0.
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Safety Precautions
Please read the safety warnings provided in this manual to ensure that you use the printer safely.
Do not attempt to use the printer in any way not described in this manual as this could result in
unforeseen printer faults or cause a fire or electric shock.

Choosing a location
Do not place the printer close to flammable sol-
vents such as alcohol or thinner.

If flammable solvents
come in contact with elec-
trical components inside
the printer, such sub-
stances could cause a fire
or electric shock.

Never damage, modify, stretch or excessively
bend or twist the power cord. Do not place
heavy objects on the power cord.

Power leaking from a
damaged power cord could
cause a fire or electric
shock.

Never plug the printer into a power socket that
is shared with other equipment (power board,
double adapter, etc.).

This could cause a fire or
electric shock.

Never use the printer while the power cord is
bundled or knotted.

This could cause a fire or
electric shock.

If you detect smoke, unusual odours or strange
noises around the printer, immediately press the
POWER button to switch the printer off and
always unplug the power cord.

Continuing to use the
printer in these circum-
stances could cause a fire
or electric shock.  Call for
service.

Power supply

The power outlet and power plug shapes may
be different depending on the country of pur-
chase.

Never attempt to plug the power cord into the
power outlet or unplug the power cord when
your hands are wet.

This could cause an elec-
tric shock.

Always push the plug all the way into the power
outlet.

A loose or poorly inserted
plug could cause a fire or
electric shock.
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Safety Precautions

Cleaning the printer
Use a damp cloth to clean the printer.  Never
use flammable solvents such as alcohol, ben-
zene or thinner.

If flammable solvents
come in contact with elec-
trical components inside
the printer, such sub-
stances could cause a fire
or electric shock.

Choosing a location
Do not install the printer in a location that is
unstable or subject to excessive vibration.

The printer could tip over
or fall and cause injury.

Always unplug the printer from the power outlet
when you are cleaning the printer.

If you mistakenly switch
the printer on while clean-
ing it, you could touch
moving internal printer
components and suffer
injury.

Maintaining the printer
Do not attempt to disassemble or modify the
printer.

The printer contains high-
voltage components that
could cause a fire or elec-
tric shock.

Working around the printer
Do not use inflammable sprays near the printer.

Gases in the spray could
cause a fire or electric
shock if they come in con-
tact with electrical compo-
nents inside the printer.

Do not install the printer in locations that are
very humid or dusty, in direct sunlight, or close
to a heating appliance or fireplace.

To avoid the risk of fires
or electric shocks, install
the printer in a location
with an ambient tempera-
ture range of 5°C to 35°C
(41°F to 95°F) and humid-
ity of 10% to 90% (no
condensation).

Do not place the printer on a thick rug or carpet.
Fibres or dust entering the
printer could cause a fire.

Keep the power outlet for the printer free of all
obstacles so you can unplug the power cord at
any time.

Any obstacles could pre-
vent you from unplugging
the printer when a printer
fault occurs and thereby
cause a fire or electric
shock.
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When you are carrying the printer, always use
both hands and hold the printer by both ends.

When you are moving the
printer to another location,
keep it stable so that you
do not drop it and cause
injury.

Working around the printer
Never put your hands or fingers in the printer
while it is printing.

The printer contains mov-
ing parts that could cause
injury.

Do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alco-
hol, thinners, etc.) on the top of the printer.

Such objects could fall or
spill into the printer and
cause a fire or electric
shock.

If any foreign objects (metal or liquid) enter the
printer, switch the printer off, unplug the power
cord and call for service.

Continued use of the print-
er when a foreign object
has fallen into the printer
could cause a fire or elec-
tric shock.

Power supply

The power outlet and power plug shapes may
be different depending on the country of pur-
chase.

Always grasp the plug when you unplug the
power cord.

Unplugging the power
cord by pulling on the cord
itself can damage the cord
and cause a fire or electric
shock.

Do not use an extension cord.
This could cause a fire or
electric shock.

Never use a power supply voltage other than
that supplied in the country of purchase.

Using the incorrect voltage
could cause a fire or elec-
tric shock.  The correct
power supply voltages and
frequencies are as follows:
Europe

AC 230V±10%, 50Hz
USA/Canada

AC 120V, 60Hz
Australia

AC 240V, 50Hz

BJ Cartridges and ink cartridges
For safety reasons, store BJ Cartridges and ink
tanks out of the reach of small children.

If a child inadvertently
licks a BJ Cartridge or ink
tank or ingests any ink,
consult a physician imme-
diately.



General Approval (Regulations for the United Kingdom)
This equipment is approved under approval number NS/G/12345/J/100003 for indirect connection
to public communication systems in the United Kingdom (i.e. when connected to the correct inter-
face of a type approved apparatus in accordance with the instructions for use of that apparatus).
If you are uncertain about the connection arrangement, seek the help of a qualified engineer.

Interference-causing Equipment Regulations (Canada)
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital
apparatus as set out in the interference-causing equipment standard entitled "Digital Apparatus",
ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur la matériel brouilleur: "Appareils
Numériques", NMB-003 édicatée par l'Industrie Canada.
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Safety Precautions

Do not subject BJ Cartridges or ink tanks to
shocks or excessive vibration.

This could cause the ink to
leak out and stain your
clothing or the surround-
ings.

Never touch the metal contacts on a BJ
Cartridge after printing.

The metal parts may be
very hot and could cause
burns.

Using the printer near appliances such as fluorescent lamps.
Allow at least 15cm (approximately 6 inches) clearance between the printer and an appliance such
as a fluorescent lamp.  Electrical noise generated by a fluorescent lamp placed too close to the print-
er will cause printer malfunctions.

Switching the printer off
To avoid printer malfunctions, always use the POWER button to switch the printer on and off.  Never
remove the power cord from the power outlet until the printer has been switched off by pressing the
POWER button.  Be sure to unplug the power cord from the power outlet after the POWER lamp
goes off.
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Parts and Functions of the Printer
Front View

Paper Guide
Ensures that the sheets from the stack in the auto sheet feeder feed straight into the printer.  Always align this guide with the
left edge of the paper loaded in the auto sheet feeder.

Paper Rest
Raise to support the paper, especially a larger paper size.

Auto Sheet Feeder
Holds sheets of paper or other media for printing.  The auto sheet feeder holds multiple sheets which are automatically fed
into the printer one sheet at a time.

Front Cover
Open to install, replace or switch the BJ Cartridges, or to remove a paper jam.

Paper Output Tray
Holds printed sheets after they are ejected from the printer.

Operation Panel
POWER button
Press to switch the printer on and off.

POWER lamp
Lights to indicate the status of the printer.

Off : Printer power off.
On (green) : Ready for operation.
Flashing (green) : Standby status or print job in progress.
Flashing (orange) : Printer error.  Remove the cause of the error before printing is resumed.
Flashing (Flashes orange and : Service error.  Contact a Canon service facility.

green alternately.)

RESUME button
After you have removed the cause of a printer error, press the RESUME button to resume printing.
Press and hold the RESUME button for the required number of flashes and release to perform these special tasks.

One flash: Cleans the print head.
Two flashes: Prints a nozzle check pattern.
Three flashes: Cleans the paper feed rollers.

These important tasks can also be performed with the printer driver.

Paper Thickness Lever
Adjusts the gap between the print head and the surface of the paper for the type of paper you are printing on.

Paper Guide

Front Cover

Paper Thickness Lever

POWER button RESUME button

POWER lamp
Operation Panel

Paper Output Tray

Paper Rest

Auto Sheet Feeder
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Rear View

Printer Cable Connector (Parallel Interface)
Provides a connection point for connecting a parallel interface cable to the printer.

Printer Cable Connector (USB Interface)
Provides a connection point for connecting a USB interface cable to the printer.

Power Connector
Provides a connection point for connecting the power cord to the AC power outlet.  The power cord may be permanently
attached to the printer, depending on the country of purchase.

Inside the Printer

Cartridge Lock Lever
Locks the BJ Cartridges onto the cartridge holder.

Cartridge Holder
Holds a BJ Cartridge or scanner cartridge.

Parts and Functions of the Printer

Printer Cable Connector (Parallel Interface)

Printer Cable Connector (USB Interface)

Cartridge Lock Lever

Cartridge Holder

Power Connector



Notes on Handling the USB Interface
When you use the printer through the USB interface, you can connect or disconnect the USB inter-
face cable while the printer and computer are turned on.  However, you must take care over the fol-
lowing points.

Printer Cable Connector (USB Interface)

■ Follow the correct order to install the printer driver properly.
When you connect the printer and computer using the USB interface cable, follow the order
described in the Getting Started manual.
If you fail to follow the correct order, the printer driver may not be installed properly.

■ Do not connect or disconnect the USB interface cable in the following circum-
stances.
When you use the printer with the USB interface, you can connect or disconnect the USB interface
cable while the printer and computer are turned on.  However, do not connect or disconnect the
USB interface cable in the following circumstances; the printer and computer may not operate
properly.

- While the printer driver is being installed
- While the operating system (Windows 98 or Mac OS) is starting up
- While the printer is printing

■ Wait for at least 5 seconds before connecting the USB interface cable again.
When you disconnect the USB interface cable while the printer and computer are turned on and
connect it again, wait for at least 5 seconds.  If you connect the USB interface cable immediately
after disconnecting, the printer and computer may not operate properly.

10

Rear View
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■ When you connect multiple printers using the USB interface, use the external
USB hub.
When you connect multiple printers using the USB interface, use the external USB hub and then
install the printer driver. (when using Windows 98, install the printer driver each time you connect
the printer.) 
For more details, please refer to the Driver and Utility Guide for Windows Users or the Driver and
Utility Guide for Macintosh Users in the Reference Guide (CD-ROM), depending on the computer
system you are using.

■ Disconnect the USB interface cable on the side of the computer or USB hub.
When you disconnect the USB interface cable while the printer and computer are turned on,
always disconnect on the side of the computer or USB hub.

■ Do not turn the printer off while the printer is executing a print job. This could
cause a malfunction in the printer.

Notes on Handling the USB Interface
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Printing Your Document
After you set up the printer, start printing.  This section describes how to print a document on plain
paper.

Printing from Windows

1 Create a document using an application program.
(Or, open the file you wish to print.)

Specify the paper size in the application program you are using.

2 Make sure that the printer is set up properly.

➀ Make sure that the printer is switched on.

➁ Load a stack of plain paper into the auto sheet feeder.

3 Specify the print settings in the printer driver.

➀ Open the Printer Properties dialogue box.

Select the command used for printing, then click the
Properties button. (Depending on the application pro-
gram you use, the print operation procedure may be dif-
ferent.  Refer to the documentation of your application
program.)

POWER lamp
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➁ Specify the necessary print settings in the printer driver.
(For details, see next page.)

➂ Click the OK button to close the Printer Properties dia-
logue box.

4 Start printing from the application program.

Click the OK button.  Printing begins.

The following screen appears during printing.

➀ BJ Backgrounder
The BJ Backgrounder is displayed to the lower right corner of the screen.  You can cancel or pause the print
job.

➁ BJ Background Monitor
The BJ Background Monitor is launched automatically and is minimised on the Windows Taskbar.  You can
cancel the print job, change the order of the documents you print or even switch the priority of background
printing over the processing of another application program.

➂ BJ Status Monitor
The BJ Status Monitor checks the status of the printer.  If an error occurs, the BJ Status Monitor displays the
cause of the error and a solution.  The BJ Status Monitor also detects the remaining ink of the BJ Cartridge
and displays a warning message when the ink is low.

Printing Your Document

➀

➁ ➂
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About the Printer Properties dialogue box

The printer driver is a program that converts the text or image files you created with an application
program and then sends the converted data to the printer.  The printer driver works on processing
the data so the printer can use it.
This section describes the main tab in the Printer Properties dialogue box. (You can specify various
print settings in the Page Layout, Stamp/Background and Maintenance tabs.)
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Printing Your Document

Choose Print Mode:
Several print modes are pre-registered here.  When you select an icon in the Choose Print Mode
box, the combination of BJ Cartridge and Media Type settings changes automatically.  Select the
most appropriate icon according to your print purpose.

BJ Cartridge:
Specifies the type of BJ Cartridge to use.

[Black] : when black BJ cartridge is to be used for printing.
[Colour] : when colour BJ cartridge is to be used for printing.
[Photo] : when photo BJ cartridge is to be used for printing.

Media Type:
Specifies the type of print media to use.

Make sure that the Page Size setting in the Page Layout tab is identical to the paper size setting in your applica-
tion program.

Illustrated Guideline:
Displays information on the paper feed method, the position of the paper thickness lever and the
printer driver settings.

OK button:
Enables the print settings in the printer driver and closes the Printer Properties dialogue box.

Cancel button:
Cancels the current print settings in the printer driver and closes the Printer Properties dialogue box.

The Driver and Utility Guide for Windows Users section in the Reference Guide describes detailed print settings
in the printer driver for Windows.  Reading this on-line manual is recommended.



Printing Your Document
After you set up the printer, start printing.  This section describes how to print a document on plain
paper.

Printing from a Macintosh

1 Create a document using an application program.
(Or, open the file you wish to print.)

Specify the paper size by selecting Page Setup from the File menu.

Specify the paper size in the Page Setup dialogue box. (Depending on the application program
you use, the paper size setting and print operation procedures may be different.  Refer to the
documentation of your application program.)

2 Make sure that the printer is set up properly.

➀ Make sure that the printer is switched on.

➁ Load a stack of plain paper into the auto sheet feeder.

3 Specify the print settings in the printer driver.

➀ Select the command used for printing to open the dialogue box.

Normally select Print and Page Setup from the File menu. 

16

POWER lamp
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➁ Specify the necessary print settings in the printer driver. (For details, see next page.)

4 Start printing from the application program.

Click the Print button.  Printing begins.

The following screen appears during printing.

- When a single Macintosh computer is connected to the printer :
- While printing from the print server in a network environment :

The print progress is displayed.

- While printing from a client unit in a network environment :
The data transmission progress to the print server is displayed.

Printing Your Document
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About the Printer Properties dialogue box

The printer driver is a program that converts the text or image files you created with an application
program and then sends the converted data to the printer.  The printer driver works on processing
the data so the printer can use it.
This section describes the Printer Properties dialogue box when you select Print from the File menu.
(You can also specify other print settings by selecting Page Setup from the File menu.)
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BJ Cartridge:
Specifies the type of BJ Cartridge to use.

[Black] : when black BJ cartridge is to be used for printing.
[Colour] : when colour BJ cartridge is to be used for printing.
[Photo] : when photo BJ cartridge is to be used for printing.

Print Mode:
Several print modes are pre-registered here.  Select the most appropriate icon according to your print
purpose.

Print button:
Enables the print settings in the printer driver and starts a print job.

Cancel button:
Cancels the current print settings in the printer driver and closes the Printer Properties dialogue box.

Print Settings Display:
Displays information on the paper feed method, the position of the paper thickness lever and the
printer driver settings.

Media Type:
Specifies the type of print media to use.

The Driver and Utility Guide for Macintosh Users section in the Reference Guide describes detailed print set-
tings in the printer driver for Macintosh users.  Reading this on-line manual is recommended.

Printing Your Document
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Loading Paper (A4 size)
This section describes the paper loading procedure using A4-size plain paper.

Using Plain Paper

1 Raise the paper rest.

2 Fan the stack to remove static cling and align
the edges of the stack by tapping it on a flat
surface. (Loading the paper without first fan-
ning and aligning the edges could cause
paper jams.)

To avoid touching the print surface, always handle media by the edges.  Unclean or scratched
print surfaces can adversely affect print quality.

3 Load the stack of paper as follows.
➀ Align the stack with the right side of the auto sheet

feeder and insert it into the auto sheet feeder. 
(You can print on either side of plain paper.)

➁ Slide the paper guide to the left side of the stack 
until it is snug.

Make sure that the top of the stack is not higher than the load limit mark.  Maximum load capaci-
ty for plain paper is approximately 100 sheets (64 g/m2).

4 Make sure that the paper thickness lever is set to the Up position.

Paper rest

Paper guide

Load limit mark
Print side
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When the print job is finished...
Check the printed sheets as they are ejected from the printer.
As soon as about 20 sheets have stacked on the paper output tray, remove them.
If the printed sheets are excessively curled after they are ejected from the printer, remove each
sheet immediately to prevent curled sheets from blocking other sheets ejected from the printer.

Printing area

To ensure the best print quality, the printer allows a margin along each edge of the media. (The print-
ing area varies according to the media size.)
Please note that the term "printing area" represents both the recommended area for the optimum
print quality and the entire area where the printer can technically print.

Printing area (dark shade):
Canon recommends that you print within this area.

Printable area (light shade):
The area in which it is possible to print.  However, printing in this area can adversely affect the print
quality or the paper feed precision.  The printable area for A4-size paper is 203.2mm(W) x
289.0mm(H) (8"x 11-3/8").

Loading Paper (A4 size)
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About a Variety of Print Media
This section describes the types of print media you can use with the printer.  For more details, refer
to the Reference Guide.

■ Ordinary Paper
● Plain Paper

Standard photocopier paper can be used if its weight is within the range of 64 to 105 g/m2.  Canon colour
BJ plain paper (LC-301) can also be used.

To prevent paper jams and other problems, never use media heavier than 105 g/m2.

● Envelopes
The standard European DL and US Commercial #10 sizes can be used.  Do not use other envelope sizes.

Canon offers a range of special paper and films for the reproduction of superb images in vibrant colours.  For
best results when printing photographs, use the Photo BJ Cartridge.

■ Canon Special Media
● High Resolution Paper HR-101S

Provides more vivid colours than plain paper.  Ideal for printing photographs or business documents that
include large numbers of colour illustrations and graphs.

● High Gloss Photo Film HG-201
A film sheet with a higher gloss than Glossy Photo Paper GP-301.  You can print high-resolution pho-
tographs by using the colour BJ cartridge.

● Back Print Film BF-102
This white translucent film is ideal for displays that use backlighting to show a printed image in the same
way as slides and stained glass.
Please note that the original image is reversed horizontally (mirrored) when printed.

● Transparencies CF-102
These can be used to prepare materials for use with an overhead projector.
To avoid paper jams and other problems, never use transparencies intended for use with other Canon BJ
printers (e.g., CF-101), laser beam printers or photocopiers.

● Glossy Photo Paper GP-301
Slightly heavier than High Resolution Paper because a gloss coating is applied to the print side of the
paper.  Provides near-photographic quality images with the glossy feel of a photographic print.

● Glossy Photo Cards FM-101
A special card made of the same stock as Glossy Photo Paper GP-301.  You can obtain a Photo Card
printed over its entire area by printing the image so that it extends beyond the perforations and then trim-
ming off the unwanted white margins.
Use this card when you want to print a colour or a photo over the entire card.

● Banner Paper
This banner paper allows you to print on up to six connected sheets of A4 or Letter size paper to create
party or advertising banners.

● T-Shirt Transfer TR-201
This is a media for creating iron-on prints for T-shirts.  You can make an original T-shirt simply by printing
your favourite photograph or illustration onto this media.
Please note that the original image is reversed horizontally (mirrored) when printed.



Notes on Handling Print Media

■ To avoid poor print quality and possible damage to the printer, never use the types
of media listed below.

- Folded paper
- Curled paper
- Creased or crumpled paper
- Damp or wet paper
- Excessively thin media (weight less than 64 g/m2)
- Excessively thick media (weight more than 105 g/m2)
- Continuous feed paper (tractor feed)
- Punched paper (loose-leaf folder inserts, etc.)
- Reply-paid postcards (i.e., double postal card)
- Postcards with a photograph printed on the reverse side
- Postcards with a photograph or sticker pasted on
- Envelopes with overlapping flaps
- Envelopes with pressure seals
- Envelopes with embossed or treated surfaces

• To avoid touching the print surface, always handle media by the edges.  Unclean or scratched print
surfaces can adversely affect print quality.

• When storing the print media, put the print media back in its original packaging and avoid locations
that are exposed to direct sunlight or that are subject to high temperatures or humidity.  To avoid
curling or wrinkling the paper, store it in a level place.

• After printing, do not touch the print side until the ink has dried.  If water gets on the printed media,
do not touch the print side until the ink has dried.  The following are guidelines on how long ink
takes to dry on individual print media.

- Glossy Photo Paper GP-301 About 2 minutes
- Glossy Photo Cards FM-101 About 2 minutes
- High Gloss Photo Film HG-201 About 2 minutes
- Transparencies CF-102 About 15 minutes
- Back Print Film BF-102 About 15 minutes
- T-Shirt Transfer TR-201 Refer to the instructions on the packaging

About a Variety of Print Media

23



24

Using the BJ Cartridges and Scanner Cartridge
About Cartridge Types

- When you perform a print job, a BJ Cartridge must be installed onto the cartridge holder.  When the
ink of a specific colour runs out, only the empty ink tank needs to be replaced.

- When you wish to scan an image, the scanner cartridge must be installed for scanning instead of
the BJ Cartridge.

Replacing the Ink Tanks (➡ p.30)
Replacing the BJ Cartridge (➡ p.33)

■ Colour BJ Cartridge BC-33

Uses pigment black ink and the standard three
colour inks (cyan, magenta, yellow).

■ Photo BJ Cartridge BC-34 Photo

Uses two colour inks (photo cyan and photo
magenta) which are rather lighter than the standard
cyan and magenta, dye black ink, and standard
yellow ink.  This cartridge should be used when
printing natural images such as photographs.

Ink Tank

BCI-3Y

Yellow

Ink Tank

BCI-3M

Magenta

Ink Tank

BCI-3C

Cyan

Ink Tank

BCI-3BK

Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3M

Magenta

Ink Tank
BCI-3BK

Black

Ink Tank
BCI-3C

Cyan

Ink tank

Cyan: Ink Tank BCI-3C

Magenta: Ink Tank BCI-3M

Yellow: Ink Tank BCI-3Y

Black: Ink Tank BCI-3BK

Ink Tank

BCI-3Y

Yellow

Ink Tank

BCI-3PM
Photo

Photo
Magenta

Ink Tank

BCI-3PC
Photo

Photo
Cyan

Ink Tank

BCI-3PBK
Photo

Photo
Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3PBK

Photo

Photo
Black

Ink Tank
BCI-3PM

Photo

Photo
Magenta

Ink Tank
BCI-3PC

Photo

Photo
Cyan

Ink tank

Photo Cyan:
Ink Tank BCI-3PC Photo

Photo Magenta:
Ink Tank BCI-3PM Photo

Yellow:
Ink Tank BCI-3Y

Photo Black:
Ink Tank BCI-3PBK Photo
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■ Black BJ Cartridge BC-30

Uses pigment black ink.  Pigment black ink is best for
printing sharp black characters.  Although it is relatively
slow to dry, it is waterproof after drying.
This cartridge should be used for printing monochrome
documents only.

■ Color Image Scanner Cartridge IS-32

The Color Image Scanner Cartridge IS-32 incorporates
special optical components to scan the image.  When
you wish to use the printer as a scanner, install this
scanner cartridge instead of a BJ Cartridge.

Using the Scanner (➡ p.36)

For safety reasons, store BJ Cartridges and ink tanks out of the reach of small children.
If a child inadvertently licks a BJ Cartridge or ink tank or ingests any ink, consult a physician immedi-
ately.

•  Do not leave an empty ink tank in a BJ Cartridge.  Remove it immediately after ink runs out.
•  If a used ink tank which is still usable must be removed for some reason, keep the ink tank

installed in the BJ Cartridge.  Otherwise the ink will dry and print jobs may not be performed prop-
erly after the ink tank is installed again.

Replacing the Ink Tanks (➡ p.30)

For optimum print quality, an ink tank or BJ Cartridge should be used up within six months or a year
respectively, after opening the original packaging.

Using the BJ Cartridges and Scanner Cartridge

Ink Tank

BCI-3BK

Black
Ink Tank

BCI-3BK

Black

Black: BCI-3BK

Ink tank
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About Cartridge Combinations

You can get better results from your printer if you exchange the BJ cartridge depending on the work
that you are doing.  Read the following, and switch the cartridges in accordance to your task.  (The
figures show the cartridge holder, the cartridges to be installed, and the ink tanks.)

■ Standard colour combination

Use the colour BJ Cartridge (BC-33) for the following:
● Printing monochrome documents
● Printing general colour drafts
● Colour printing of photographs when the best 

possible quality is not needed

For more details, refer to the Getting Started manual.

■ Photo colour combination

Use the photo BJ Cartridge (BC-34 Photo) for the following:
● Printing photographs with the best possible resolution
● Printing scanned images (photographs) with the best 

possible resolution

Installing the Photo BJ Cartridge (➡ p.28)

Printing only monochrome documents

The black BJ Cartridge (BC-30) should be used only when monochrome documents, and no colour
documents, are to be printed.  The ink tanks of the BJ cartridge are removable, so that you only have
to exchange the ink tank (BCI-3BK) when you run out of ink. 

Replacing the BJ cartridge (➡ p.33)

Ink Tank
BCI-3BK

Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3M

Magenta

Ink Tank
BCI-3C

Cyan

Ink Tank
BCI-3PBK

Photo

Photo
Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3PM

Photo

Photo
Magenta

Ink Tank
BCI-3PC

Photo

Photo
Cyan
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■ Scanner combination

When you wish to use the printer as a scanner for
scanning an image, install the Color Image Scanner
Cartridge IS-32.  

Using the Scanner (➡ p.36)

Discard empty ink tanks immediately according to the local laws and regulations regarding disposal
of consumables.

Using the BJ Cartridges and Scanner Cartridge
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Installing the Photo BJ Cartridge
Use of the Photo BJ Cartridge is recommended when you print image data such as a photograph
from a digital camera or scanner which requires fine halftone colours.

For a print job using the Photo BJ Cartridge, be sure to install the Photo BJ Cartridge and ink tanks
in the right positions as shown in the following figures.

1 Make sure that the printer is switched on and
open the front cover of the printer.  
The cartridge holder moves to the left.

2 Raise the blue cartridge lock lever on the car-
tridge holder(➀) and remove the Color BJ
Cartridge(➁).

After removing a BJ Cartridge, always keep
the BJ Cartridge in the BJ Cartridge container.
Otherwise the ink will dry and print jobs may
not be performed properly after the ink tank is
installed again.

3 Remove the Photo BJ Cartridge (Color BJ
Cartridge BC-34 Photo) from its package.  
Remove the orange protective cap(➀) and protec-
tive tape(➁).

4 Set the Photo BJ Cartridge in the cartridge holder.

5 Lower the cartridge lock lever(➀) and press it
down until it locks into place, and then press in
the fix tabs(➁) to remove two orange plastic
inserts.

Front cover

Cartridge
holder

Blue cartridge lock lever

Remove these
two items.

Do not touch
these precision
components.

Ink Tank
BCI-3BKBlack

Ink Tank
BCI-3YYellow

Ink Tank
BCI-3MMagenta

Ink Tank
BCI-3CCyan

Fix tabs
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6 Pick up the Ink Tank BCI-3Y (Yellow) and pull up
on the orange tape to break the seal of the clear
film.

7 Grip the bottom of the ink tank as shown and
twist off the orange protective cap in the direction
of the arrow.

Do not press this side of the ink tank, to prevent ink spills.

8 Install the ink tank in the first slot of the BJ
Cartridge.
Gently press down on top of the ink tank until it
locks into place.

9 In the same way, set a photo magenta ink tank
(BCI-3PM) (➀) and photo cyan ink tank (BCI-
3PC) (➁) starting from the right, in the stated
order.  Press in the photo black ink tank (BCI-
3PBK) firmly until it clicks into place.  (➂)

10Close the front cover.

This completes the installation procedure of the
Photo BJ Cartridge.

• Never attempt to re-attach the protective caps and tapes 
to the BJ Cartridge or ink tank.

• To avoid poor quality printing, never touch the print heads.

When using the Photo BJ Cartridge for the first time...
You need to align the print head and select the appropriate print settings in the printer driver.

➡ Aligning the Print Head (➡ p.55)
➡ Driver and Utility Guide for Windows Users (CD-ROM)
➡ Aligning the Print Head (➡ p.57)
➡ Driver and Utility Guide for Macintosh Users (CD-ROM)

Installing the Photo BJ Cartridge
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Replacing the Ink Tanks
The following pages describe how to replace empty ink tanks.

When you purchase extra ink tanks, make sure that you get the correct ink tanks for each BJ
Cartridge.

- For Color BJ Cartridge BC-33 Ink Tank BCI-3BK
Ink Tank BCI-3C
Ink Tank BCI-3M
Ink Tank BCI-3Y

- For Color BJ Cartridge BC-34 Photo Ink Tank BCI-3PBK Photo
Ink Tank BCI-3PC Photo
Ink Tank BCI-3PM Photo
Ink Tank BCI-3Y

- For Black BJ Cartridge BC-30 Ink Tank BCI-3BK

1 Make sure that the printer is switched on and
open the front cover of the printer.  
The cartridge holder moves to the left.

2 To remove the empty ink tank, press in the
tab(➀) on the ink tank to release and pull it out
of the slot(➁).
Do not remove the BJ Cartridge!  Leave the BJ Cartridge
installed in the printer and remove only the ink tank(s).

• If you need to replace more than one ink tank, do not
remove the ink tanks together.  Remove and replace
each ink tank one by one to ensure that each new ink
tank is inserted in the correct slot.  If you insert an ink
tank in the wrong slot, colours will not print correctly.

• Do not leave an empty ink tank in the BJ Cartridge.  Remove it immediately after the ink runs
out.

• If a partially used ink tank must be removed for some reason, keep the ink tank installed in the
BJ Cartridge.  Otherwise the ink will dry and print jobs may not be performed properly after the
ink tank is installed again.

To avoid staining your hands, clothing, or areas of the work site, do not shake or drop ink tanks
when you are handling them.

Discard empty ink tanks immediately according to the local laws and regulations regarding dis-
posal of consumables.

Front cover

Cartridge
holder
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3 Remove the new ink tank from its package.  Pull
the orange tape up and against the perforations
to open the packing film.

Remove the film carefully so you do not
remove the label from the ink tank.  The
label is needed to match the ink tank with
the correct slot of the BJ Cartridge.

4 Grip the bottom of the ink tank as shown in the
figure and twist off the orange protective cap in
the direction of the arrow.

• Never attempt to reattach a protective cap to an ink tank.
Discard the protective cap according to the local laws and
regulations regarding disposal of consumables.

• To avoid interfering with the ink supply from a tank, do not
touch an open ink port on the ink tank.

5 Hold the new ink tank at a slight angle, align it
with the correct slot, then press down gently on
top of the ink tank until it locks in place.

Make sure that you insert the ink tank in the correct slot.
The following figures show the correct array of ink tanks in
the BJ Cartridges.

Standard colour combination
Color BJ Cartridge BC-33

BCI-3BK (Black)
BCI-3C (Cyan)
BCI-3M (Magenta)
BCI-3Y (Yellow)

Replacing the Ink Tanks

Ink Tank
BCI-3BK

Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3M

Magenta

Ink Tank
BCI-3C

Cyan

Label
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Photo colour combination
Color BJ Cartridge BC-34 Photo

BCI-3PBK Photo (Black)
BCI-3PC Photo (Cyan)
BCI-3PM Photo (Magenta)
BCI-3Y (Yellow)

6 To lock the ink tank in place, press down on top
of the ink tank.

Press down until you hear the ink tank lock in place.

7 Close the front cover.

The cartridge holder returns to the home position and print
head cleaning starts automatically.
The POWER lamp blinks during print head cleaning.  When
print head cleaning is finished and the POWER lamp stops
flashing, you can resume normal operation. (Do not perform
other tasks on the printer until the POWER lamp stop flash-
ing.)

Ink Tank
BCI-3PBK

Photo

Photo
Black

Ink Tank
BCI-3Y

Yellow

Ink Tank
BCI-3PM

Photo

Photo
Magenta

Ink Tank
BCI-3PC

Photo

Photo
Cyan
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Replacing the BJ Cartridge
If the print quality remains poor even after replacing the ink tanks and cleaning the print head, the
print head is worn out and you must replace the BJ Cartridge.

Canon recommends the following BJ Cartridges for use with this printer.
Color BJ Cartridge BC-33
Color BJ Cartridge BC-34 Photo
Black BJ Cartridge BC-30

1 Make sure that the printer is switched on and
open the front cover of the printer.

The cartridge holder moves to the left.

2 Raise the cartridge lock lever all the way up to
unlock the BJ Cartridge.

The illustration shows replacement of a Color BJ Cartridge.

To avoid staining your hands, clothing, or areas in the work
site, handle the BJ Cartridge carefully.  Avoid dropping or
shaking the BJ Cartridge.

Front cover

Cartridge
holder
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3 Remove the entire BJ Cartridge with the ink tanks
in place.

• If you are removing a partially used BJ Cartridge, store it
in the BJ Cartridge container.

• Always hold the BJ Cartridge by the circles embossed on
the left and right sides of the BJ Cartridge.  Never touch
the metal contacts or the print head on the BJ Cartridge.

4 Remove a new BJ Cartridge from its package.
Remove the orange protective cap(➀) then slowly
remove the orange protective tape(➁).

• Never attempt to reattach the tape or cap to a BJ
Cartridge. Discard the protective cap and tape according
to the local laws and regulations regarding disposal of
consumables.

• Do not leave an empty ink tank in the BJ Cartridge.
Remove it immediately after the ink runs out.

• If a partially used ink tank must be removed for some rea-
son, keep the ink tank installed in the BJ Cartridge.
Otherwise the ink will dry and print jobs may not be per-
formed properly after the ink tank is installed again.

5 Insert the BJ Cartridge into the cartridge holder.

Ink Tank
BCI-3BKBlack

Ink Tank
BCI-3YYellow

Ink Tank
BCI-3MMagenta

Ink Tank
BCI-3CCyan

Remove these
two items.

Do not touch
these precision
components.
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6 Lower the cartridge lock lever until it locks in
place.

7 Press in the fix tabs to remove the orange plastic
inserts.

8 Insert the ink tanks in the new BJ Cartridge and
then press down gently on top of each ink tank
until it locks in place.

You can use new ink tanks or remove the ink tanks in the
old BJ Cartridge and install them in the new BJ Cartridge.

Replacing the Ink Tanks (➡ p.30)

9 Close the front cover.
The cartridge holder returns to the home position and print
head cleaning starts automatically.  Do not open the front
cover during print head cleaning.

The POWER lamp flashes during print head cleaning. (It
takes about 30 seconds until print head cleaning is com-
pleted and the POWER lamp stops flashing.)

Before using the new BJ Cartridge...
You need to align the print head.

➡ Aligning the Print Head (➡ p.55)
➡ Aligning the Print Head (➡ p.57)

Replacing the BJ Cartridge

Fix tabs
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Using the Scanner
Installing the Color Image Scanner Cartridge IS-32 in the printer makes it possible to scan and save
images such as your favourite photographs and greeting cards.
The Color Image Scanner Cartridge IS-32 operates in combination with the special IS Scan Software
(i.e., IS Scan scanner driver and IS Scan Plus utility program).  These two programs provide many
features that allow you to perform simple colour adjustments to improve the quality of the original
image or enhance the image for artistic effect.

- If you are using a TWAIN-compliant graphics application program...
You need the IS Scan scanner driver.  You can run IS Scan from within a TWAIN-compliant graph-
ics application program.  After scanning the image, transfer the image data to the application pro-
gram to edit, enhance and save the data, as needed.

- If you are not using a TWAIN-compliant graphics application program...
Use the IS Scan Plus utility for Windows.  IS Scan Plus allows you to scan, edit, enhance and save
the image data.

You need the IS Scan scanner driver.  IS Scan allows you to scan, edit, enhance and save the image
data.  You can run IS Scan directly as a stand-alone application program, or you can run it from with-
in a TWAIN-compliant graphics application program.

TWAIN is the name of the group that defined the standards for passing data from digital devices like
scanners to software applications running on 32-bit platforms.
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Before Using the Scanner

Check the following items before using the scanner.

■ Color Image Scanner Cartridge IS-32

Install this scanner cartridge to use the printer as a scanner.

The scanner cartridge is composed of precision components.  Do not touch the electrical contacts
and optical components, such as lenses, to avoid poor scanning results, poor contact and static
electricity.

■ White calibration sheet
Used for maintaining the correct colour balance of scanned images.
This white level calibration is needed when the scanner cartridge is
used for the first time after purchase or when the system needs to
update the white level calibration data.

■ Scanning holder
Used for holding the image you wish to scan or the white calibration
sheet.  If you want to scan images of A5 size or larger, scanning hold-
ers for other paper sizes may be optionally available depending on
the country of purchase.

■ BJ Cartridge container
Used for storing the Color Image Scanner Cartridge IS-32 or other BJ
Cartridges when not in use.  The BJ Cartridge container comes with
the printer. (If you need additional containers, the BJ Cartridge con-
tainer may be optionally available depending on the country of pur-
chase.)

■ Paper size
The following are guidelines for the scanning area.  Please note that the scanning area also varies
according to other conditions such as the scanning resolution and display resolution.

Paper size Scanning area
A5 (148 x 210mm) 141 x 200mm
A4 (210 x 297mm) 203 x 287mm 
B5 (182 x 257mm) 175 x 247mm
Letter (8.5" x 11") 8.2" x 10.6" (208 x 269mm)

Optical Components

Electrical contacts

Using the Scanner
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The following two pages describe the basic procedures from scanning to printing.

1 Install the IS Scan scanner driver.
➡Installing the IS Scan Software (p.40)

2 Install the Color Image Scanner Cartridge IS-32.

Remove the BJ Cartridge installed in the cartridge holder and then
install the Color Image Scanner Cartridge IS-32.

3 Launch a graphics application program.

➀ Launch a graphics application program as follows.

- If you use a TWAIN-compliant graphics application program, launch the TWAIN-compliant appli-
cation program.  Then launch IS Scan from within the application program.

- If you use IS Scan Plus, select Programs from the Start menu first.  Point to IS Scan Plus and
then select IS Scan Plus.

- If you use a TWAIN-compliant graphics application program, launch the TWAIN-compliant appli-
cation program first.  Then launch IS Scan from within the application program.

- If you use IS Scan as a stand-alone application program, double-click IS Scan BJC-3000 in the
folder you specified during the installation procedure.

➁ Perform white level calibration.
Load the white calibration sheet in the auto sheet feeder and click White Level.
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4 Load the image you wish to scan in the auto sheet feeder and start prescanning.
When you wish to scan only a portion of the image, use prescanning.
You can select a portion of the image for actual scanning.  This allows you to shorten the time
required for scanning.  
You can also check if the image is placed correctly in the auto sheet feeder when the prescanned
image is displayed.

➀ Insert the image you wish to scan into the scanning holder, then click Prescan.

➁ When you wish to scan only a portion of the entire image, specify the prescanning area by
dragging the mouse.

5 Load the image in the auto sheet feeder again and start scanning.

➀ Load the image you wish to scan in the auto sheet feeder again and click Scan.

➁ Save the scanned image.

6 Install the BJ Cartridge and print the scanned image.

For more details on how to use IS Scan and IS Scan Plus, refer to the Driver and Utility Guide for
Windows Users (CD-ROM) or the Driver and Utility Guide for Macintosh Users (CD-ROM).

Using the Scanner
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Installing the IS Scan Software
Before using the Color Image Scanner Cartridge IS-32, you must install the IS Scan Software.

• Before installing the IS Scan Software , quit any application programs that are running.
• If another IS Scan Software is installed in the system, uninstall the old version of the IS Scan

Software and then install the new version.

1 Load the Setup Software & Reference Guide CD-ROM into the CD-ROM drive.
Also make sure that the printer is switched on.

The CD-ROM starts automatically and a menu screen is displayed. (If the CD-ROM does not
start automatically, click the My Computer icon on the Windows desktop and then double-click
the CD-ROM icon.)

2 Click Install Software at the menu screen.

3 Click the OK button in the Select Printer dialogue box.

4 Make sure that the IS Scan Software button is
displayed is lit red.
Click IS Scan Software if the button is not red,
then click the Start button.

When you wish to learn about handling the scanner, 
click the Readme button.

Check that this button is lit red.



5 Select the desired item, then click the Next but-
ton.
- Install TWAIN driver only:
Select this item if you are using a TWAIN-compatible
application program for processing image data.  This
installs the IS Scan scanner driver only.

- Normal installation:
Select this item if you are not using a TWAIN-compatible
application program for processing image data.  This
installs the IS Scan scanner driver and IS Scan Plus utili-
ty program.

For the rest of the installation procedure, follow the instruc-
tions on the screen.

1 Load the Setup Software & Reference Guide CD-ROM into the CD-ROM drive.  

2 Double-click the CD-ROM icon.

3 Double-click the IS Scan (scanner driver) folder.

4 Double-click the folder of your language.

5 Double-click Installer.

6 Click Agree in the Software Licence Agreement screen.

7 Specify the destination of installation
as needed, then click Install.

To specify the destination of installation, follow
the procedure below.

➀ Click Select a folder to specify the destina-
tion and then click Select.

➁ Click Install.
➂ Follow the instructions on the screen.

For the rest of the installation procedure, follow the instructions on the screen.

Installing the IS Scan Software
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Scanning and Saving the Image

This section describes the basic operation procedures from launching the IS Scan software (IS Scan
Plus for Windows or IS Scan for Macintosh) to scanning and saving the image.

1 Remove the BJ Cartridge installed in the car-
tridge holder and then install the Color Image
Scanner Cartridge IS-32.

➀ Make sure that the printer is switched on and open the
front cover of the printer.  Remove the BJ Cartridge
installed in the cartridge holder.

➁ Store the removed BJ Cartridge in the BJ Cartridge con-
tainer.

➂ Install the Color Image Scanner Cartridge IS-32.
➃ Make sure that the paper thickness lever is set to the Up

position.
➄ Close the front cover.

Before closing the front cover of the printer, make sure
that the paper thickness lever is set to the Up position.  If
you scan the image with the paper thickness lever set in
the Down position, scanning results may be unsatisfacto-
ry.

2 Launch the IS Scan Software.

Select Programs from the Start menu.  Point to IS Scan
Plus, then select IS Scan Plus.  The Main menu of IS Scan
Plus screen appears.

Double-click IS Scan BJC-3000 in the folder you specified
during the installation procedure.  The Main dialogue box of
IS Scan appears.
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3 Perform white level calibration.

When you use the Color Image Scanner Cartridge IS-32
for the first time, be sure to perform white level calibration.
The white level calibration data is stored into memory and
used for maintaining the correct colour balance of scanned
images.

➀ Place the white calibration sheet in the scanning holder.
➁ Insert the scanning holder in the auto sheet feeder of

the printer.

To prevent possible damage to the scanning holder,
always insert the scanning holder into the auto sheet
feeder with its top edge (seamed side) facing down.

➂ 

Select Capture Image and then click the Custom button.

Select Settings from the Menu.

When the printer is connected using both the parallel
interface and USB interface, the Select connecting cable
dialogue box is displayed.  Select the desired port and
click the OK button.

➃ Click White Level in the Custom Settings dialogue box.
When a message appears and prompts you to load the
white calibration sheet, click the OK button.  White level
calibration begins.

➄ When the white calibration sheet is ejected from the
paper output tray, white level calibration processing is
completed.  Click the OK button.

Installing the IS Scan Software
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4 Load the image you wish to scan in the auto
sheet feeder of the printer.

➀ Place the image in the scanning holder.

➁ Insert the scanning holder in the auto sheet feeder of
the printer.

To prevent possible damage to the scanning holder,
always insert the scanning holder into the auto sheet
feeder with its top edge (seamed side) facing down.

5 Perform prescanning.

➀
Select Photo in the Scanning Mode box.  
Then select the most appropriate size to match the size
of the image you wish to scan in Paper Size.
Click the Prescan button.

➀
Select Photo in Scanning Mode.  
Select the most appropriate size to match the size
of the image you wish to scan in Paper Size.  
Check the Prescan checkbox and click the OK but-
ton.

➁ After the scanning holder which contains the image
you wish to scan is ejected from the paper output
tray, the prescanned image is displayed in black
and white.  
Make sure that the image you wish to scan is prop-
erly placed in the scanning area.
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6 When you wish to scan only a portion of the
entire image, drag the mouse to specify the por-
tion.  Follow the procedure below.

➀ Point to a corner of the rectangle for the area on the
image you want to select.

➁ Drag the mouse to the opposite corner of the rectangle.
➂ Release the mouse button.  The specified rectangle

appears on the image.

• When you wish to change the portion you specified,
place the mouse pointer within the portion and drag
the mouse to the desired position.

• When you wish to cancel the portion you specified, fol-
low the procedure below.

Right-click on the image.  The rectangle disap-
pears and you can specify the portion of the
image again.

While pressing the Control key, click on the
image.  The rectangle disappears and you can
specify the portion of the image again.

7 Load the image you wish to scan in the auto sheet feeder again.
Be careful that the image does not move in the scanning holder.

8 Start scanning the image.
After the scanning holder which contains the image is ejected from the paper output tray, the
scanned image is displayed.

When you scan printed images from books and magazines, the scanned image may appear to
be shaded.  To solve the problem, use a lower resolution setting and try again.

Installing the IS Scan Software

Drag the mouse.
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9 Save the image.

➀ Click the Save button.

➁ When the Save As dialogue box is displayed, enter the necessary items, such as a file name
and file format type, and click the Save button.

10Exit the IS Scan software.

Click the Exit button. (If you wish to print the scanned image, proceed with the printing operation
before you exit IS Scan Plus.)

Select Exit from the File menu. (If you wish to print the scanned image, exit IS Scan and then
proceed with the printing operation.)
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Printing the Image

Before printing the scanned image, replace the Color Image Scanner Cartridge IS-32 with the BJ
Cartridge.

1 Replace the Color Image Scanner Cartridge IS-
32 with the BJ Cartridge.

➀ Open the front cover of the printer.  Remove the scan-
ner cartridge installed in the cartridge holder.

➁ Store the removed scanner cartridge in the BJ Cartridge
container.

➂ Install the BJ Cartridge.
➃ Close the front cover.

After the BJ Cartridge is installed...
You need to align the print head and select the appropriate print settings in the printer driver.

➡ Aligning the Print Head (➡ p.55)
➡ Aligning the Print Head (➡ p.57)

2 Print the scanned image.

Click the Print button. 

Launch the graphics application program that allows you to print the image, and open the image
file you saved in step 9 on p.46.  Select the command used for printing.

Installing the IS Scan Software
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Routine Maintenance
This section describes the maintenance procedure for the BJ Cartridge and cleaning method for the
printer.

When to Replace the BJ Cartridge

The ink tanks and print heads of the BJ Cartridge are consumable items.  Read the following guide-
lines.

If printouts are faint, streaked or the colour tones are not correct, open the front cover of the printer
and check the remaining ink in the ink tanks.

■ Ink runs out
When ink runs out, the BJ Status Monitor displays an error message (when using Windows) and
the POWER lamp flashes in orange four times.

See "Replacing the Ink Tanks". (➡ p.30)

■ Ink remains but printouts are faint, streaked or the colour tones are not correct
If printouts are still unsatisfactory after replacing the ink tanks, the print heads may be clogged or
worn out.  Follow the procedure below.

Print a nozzle check pattern. (➡ p.49 or p.50)

If the nozzle check pattern cannot be printed properly...

Perform normal print head cleaning. (➡ p.51)

If the problem cannot be solved...

Perform deep print head cleaning. (➡ p.53)

If the problem still cannot be solved...

Replace the BJ Cartridge. (➡ p.33)

Align the print head (➡ p.55 or p.57)
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Printing a Nozzle Check Pattern 

The nozzle check pattern confirms whether the inks are being correctly ejected from the print head
nozzles and whether the print head on the BJ Cartridge is correctly aligned.  Print the nozzle check
pattern when the printouts are streaked or the colour tones are not correct, or after print head clean-
ing has been performed.

You can also print the nozzle check pattern directly from the printer.  Hold down the reset button, and
release it after the power lamp flashes twice.

1 Make sure that the printer is switched on and A4- or Letter-size plain paper is
loaded in the printer.

2 Select the nozzle check pattern in the printer driver.

➀ Open the Printer Properties dialogue box, then click the
Maintenance tab.

➁ Click the nozzle check pattern icon in the Test Prints box.

➂ When a confirmation message appears, click the OK button.

3 Look at the check patterns and perform the correction procedure if necessary.
Separate patterns are printed to display the status of the Color BJ Cartridge.

(When the Color BJ Cartridge is installed)

When the Photo BJ Color Cartridge is installed in the printer, refer to the "Printing a Nozzle
Check Pattern" section in the Reference Guide.

Routine Maintenance

BJ Cartridge nozzle check pattern
If the pattern is broken, missing or a
specific colour is not printed, see
“Cleaning the Print Head”.

BJ cartridge head position
If this portion is misaligned, refer to
"Aligning the print head".
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Printing a Nozzle Check Pattern 

The nozzle check pattern confirms whether the inks are being correctly ejected from the print head
nozzles and whether the print head on the BJ Cartridge is correctly aligned.  Print the nozzle check
pattern when your printouts are streaked or the colour tones are not correct, or after print head clean-
ing has been performed.

You can also print the nozzle check pattern directly from the printer.  Hold down the reset button, and
release it after the power lamp flashes twice.

1 Make sure that the printer is switched on and
A4- or Letter-size plain paper is loaded in the
printer.

2 Select the nozzle check pattern in the printer 
driver.

➀ Select Page Setup from the File menu, then click the
Utilities button.

➁ Select Test Print.

➂ Select Nozzle check pattern.

➃ Click the OK button.

3 Look at the check patterns and perform the correction procedure if necessary.
Separate patterns are printed to display the status of the Color BJ Cartridge.

(When the Color BJ Cartridge is installed)

When the Photo BJ Color Cartridge is installed in the printer, refer to the "Printing a Nozzle
Check Pattern" section in the Reference Guide.

BJ Cartridge nozzle check pattern
If the pattern is broken, missing or a
specific colour is not printed, see
“Cleaning the Print Head”.

BJ cartridge head position
If this portion is misaligned, refer to
"Aligning the print head".
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Cleaning the Print Head

Cleaning the print head clears the nozzles.  There are two ways to clean the print head: normal print
head cleaning and deep print head cleaning.  Always execute normal print head cleaning first.  If this
does not correct the problem then execute deep print head cleaning.

Cleaning the print head consumes ink so clean the print head only when necessary.

You can also execute print head cleaning directly from the printer.  Hold down the reset button, and
release it after the power lamp flashes once.

1 Make sure that the printer is switched on.

2 Select normal print head cleaning in the printer
driver.

➀ Open the Printer Properties dialogue box, then click the
Maintenance tab.

➁ Select the normal print head cleaning icon in the Print
Head Cleaning box.

➂ When a confirmation message appears, click the OK
button.  
The POWER lamp starts flashing and print head clean-
ing begins.  It takes approximately 40 seconds until the
POWER lamp stops flashing and the normal print head
cleaning operation is completed.

Routine Maintenance
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1 Make sure that the printer is switched on.

2 Select normal print head cleaning in the
printer driver.

➀ Select Page Setup from the File menu, then click
the Utilities button.

➁ Select Print head cleaning.

➂ Click the OK button.
The POWER lamp starts flashing and print head
cleaning begins.  It takes approximately 40 sec-
onds until the POWER lamp stops flashing and
the normal print head cleaning operation is com-
pleted.



■ Print a nozzle check pattern to confirm the success of normal print head cleaning.
(➡ p.49 or p.50)
If normal print head cleaning does not correct the problem, perform deep print
head cleaning.

➀ Open the Printer Properties dialogue box, then click the
Maintenance tab.

➁ Click the deep print head cleaning icon in the Print
Head Cleaning box.

➂ When a confirmation message appears, click the OK
button.  
The POWER lamp starts flashing and print head clean-
ing begins.  It takes approximately 1 to 2 minutes until
the POWER lamp stops flashing and the deep print
head cleaning operation is completed.

➀ Select Page Setup from the File menu, then click
the Utilities button.

➁ Select Print head deep cleaning.

Routine Maintenance
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➂ Click the OK button.
The POWER lamp starts flashing and print head clean-
ing begins.  It takes approximately 1 to 2 minutes until
the POWER lamp stops flashing and the deep print
head cleaning operation is completed.

For details on when to clean the print head, refer to the User's Guide.

■ Print a nozzle check pattern to confirm the success of deep print head cleaning.
(➡ p.49 or p.50)

If the cleaning had no effect, perform normal print head cleaning and deep print deep cleaning
again.  After cleaning the print head several times, if the nozzle check pattern is not satisfactory,
the print head may be worn out and the BJ Cartridge must be replaced.  See "Replacing the BJ
Cartridge". (➡ p.33)
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Aligning the Print Head

After the BJ cartridge is exchanged, align the print head position of the BJ cartridge as explained
below.

1 Confirm that the printer is turned on and place two sheets of A4 plain paper in
the auto sheet feeder.

2 Open the Printer Properties dialogue box.

➀ Click Start and select Settings-Printer.

➁ Click Canon BJ F300 and then select Properties from the File menu.

3 Select Print Head Alignment.

➀ Click the Maintenance tab to open the Maintenance
sheet.

➁ Click the Print Head Alignment icon.

4 Read the screen message and then click OK.

5 If the pattern shown on the right is printed, click
Yes in response to the confirmation message.

Routine Maintenance
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6 For the printed B1 and B2 patterns, enter the
number of the pattern in which the lines are per-
fectly aligned and then click OK.

7 When the message reappears, check that there
is paper in the printer and then click OK.

8 The pattern shown on the right is printed.

9 For the printed B1 and B2 patterns, enter the
number of the pattern in which the lines are per-
fectly aligned and then click OK.

10 If a completion message appears, click OK.

This completes print head alignment.
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Routine Maintenance

Aligning the Print Head

After the BJ cartridge is exchanged, align the print head position of the BJ cartridge as explained
below.

1 Confirm that the printer is turned on and place two sheets of A4 plain paper in
the auto sheet feeder.

2 Open the printer driver setting screen.

Open the Page Setup dialogue box.
Click the Utilities button and open the printer utility 
dialogue box.

3 Select Print Head Alignment.

➀ Select Test Print.

➁ Click Print Head Alignment.

4 Read the message displayed on the screen
and then click OK.

5 The pattern shown on the right is printed out.
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6 For the printed B1 and B2 patterns, enter the
number of the pattern in which the lines are per-
fectly aligned and then click Send.

7 When the message reappears, check that there
is paper in the printer and then click OK.

8 The pattern shown on the right is printed.

9 For the printed B1 and B2 patterns, enter the
number of the pattern in which the lines are per-
fectly aligned and then click Send.

This completes print head alignment.
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Cleaning the Printer

After long use paper dust and room dust may accumulate around the paper output slot and other
parts of the printer.

1 Press the POWER button to switch the printer off.

2 Make sure that the POWER lamp is off, then
unplug the power cord from the power outlet.

Never unplug the power cord while the printer is turned
on.  This could cause a malfunction in the printer.

To avoid personal injury from touching live printer compo-
nents, always unplug the printer before cleaning.

3 Remove the paper output tray.

4 Use a soft, dry cloth to wipe the area around the
paper output slot.

To avoid personal injury from burns or electrical shock or
damage to the printer during cleaning, never use a flam-
mable solvent such as thinner, benzene or alcohol.

■ Cleaning the Paper Feed Rollers

With frequent use of high resolution paper and other coated paper, paper dust from the coated
surfaces of such media accumulates around the paper feed rollers and may cause misfeeds and
paper jams.
If this happens, use a special cleaning sheet to clean the paper feed rollers inside the printer.  For
more details on how to clean the paper feed rollers, refer to the "Cleaning the Paper Feed Rollers"
section in the Reference Guide.

Routine Maintenance
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Troubleshooting
When a problem occurs while you are using the printer, refer to the topics listed below to resolve the
problem.  This manual describes the symptoms of only the printer problems you are most likely to
encounter.
If your problem is not described here, refer to the Reference Guide on the Setup Software &
Reference Guide CD-ROM.

■ Cannot install the printer driver ➡ p.61

■ Paper jams ➡ p.62

■ Paper misfeeds ➡ p.62

■ An error message appears ➡ p.63
● Error writing to LPT1 or USBPRN displayed ➡ p.63
● Application error or General Protection Fault ➡ p.65
● Error number (*202) displayed ➡ p.66
● Error number (*203) displayed ➡ p.66
● Error number (*300) displayed ➡ p.66

■ Printing stops in mid-job ➡ p.67

■ The POWER lamp flashes in orange ➡ p.68

■ The POWER lamp flashes orange and green alternately ➡ p.69

■ Printout is unsatisfactory ➡ p.70
● Meaningless characters or symbols printed ➡ p.70
● Printout is faint or colours are wrong ➡ p.71
● The last part of print job not printing ➡ p.72
● Print side rubbed and stained ➡ p.73
● Printed and on-screen colour do not match ➡ p.73
● Printed pages curled, warped or wrinkled ➡ p.74

■ Other problems ➡ p.75
Refer to the Reference Guide on the Setup Software & Reference Guide CD-ROM for information on
how to deal with other problems.

When an error occurs 

When the ink or paper runs out or the paper jams, the BJ Status
Monitor automatically appears.  The BJ Status Monitor is an applica-
tion that uses messages and pictures to display printing progress and
the status of the printer while it is printing.

➀ Look at the messages and pictures to determine what type of
error has occurred.

➁ Click the Guide tab and proceed as directed by the message
shown.  After you have resolved the error, printing resumes.
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Cannot install the printer driver

Cause:
Installation was interrupted.

Solution:
When you connect to the USB interface running under Windows 98, check the USB driver settings and
delete the unnecessary USB driver (if applicable).  For datails, refer to the “Additional Notes on Handing the
USB Inter face” manual provided with the printer.  Refer to the Getting Started manual and install the printer
driver using the correct procedure.  If you are reinstalling the printer driver, remove the previously installed BJ
printer driver and then install the printer driver again.

Uninstalling the printer driver

Select Programs and then BJ Printer from the Windows Start menu and click Uninstall.  Then follow the on-
screen instructions.

If an error occurred and you forcibly shut down the installer, you may not be able to install the printer driver
because Windows is no longer stable.  Restart Windows and then reinstall the printer driver.

Load the Setup Software & Reference Guide CD-ROM.  When the CD-ROM folder opens, double-click the
BJ Installer icon and then select your printer.  Click the Custom Remove tab.
Then follow the on-screen instructions.

Cause:
Other application programs are running.

Solution:
Quit all other application programs and start the installation again.

Cause:
The CD-ROM drive used for the installation is not specified correctly.

Solution:

Double-click on the My Computer icon and then double-click on the CD-ROM icon in the My Computer win-
dow.  Refer to Getting Started and proceed with the installation.

Double-click on the CD-ROM icon.  Refer to Getting Started and proceed with the installation.

Cause:
There is a problem with the CD-ROM.

Solution:

Check that Windows Explorer can successfully read the disk.
If the CD-ROM is unreadable, contact a Canon service facility.

Check that the CD-ROM icon is displayed on the screen.
If the CD-ROM is unreadable, contact a Canon service facility.

Troubleshooting
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Paper jams

Solution:
Slowly pull the paper out from the paper feed side or the paper output side, whichever is easier.

If the paper tears and some of it is left in the printer, switch the printer off, open the front cover and remove
the jammed paper fragments.

If you cannot remove the jammed paper, press the POWER button twice to eject the jammed paper automati-
cally.  Start the print job again.

Paper misfeeds

Cause:
Paper is too thick.

Solution:
Use paper of the specified thickness.
Paper within the range from 64 to 105 g/m2 can be loaded in the auto sheet feeder. 

Cause:
Auto sheet feeder overloaded.

Solution:
Check that you do not exceed the sheet feeder capacity.
Paper will not feed correctly if you exceed the described number of sheets.

Cause:
Paper rest not raised.

Solution:
The paper rest should be raised unless you are loading A5 Landscape, envelopes, or banner paper.
If the paper rest is not raised, the media will not slide fully into the paper feed slot and will not feed into the
printer correctly.
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Cause:
Paper wrinkled, curled.

Solution:
Check that you are using appropriate media. 
Paper that is folded, curled or crumpled not only feeds incorrectly, but may also cause paper jams.

An error message appears

● Error writing to LPT1 or USBPRN displayed

Cause:
Printer is not on.

Solution:
Check the POWER lamp to see if it is lit green.
If the POWER lamp is flashing, the printer is still warming up.  Please wait until the POWER lamp is continu-
ously lit green.

Cause:
Printer cable not connected correctly.

Solution:
Make sure that the printer cable is securely fastened to the computer and the printer.
For details, refer to the Getting Started manual.

Cause:
Printer cable fault.

Solution:
Try using another printer cable.
For details about the printer cable, contact the hardware manufacturer.

Cause:
Switching device or external buffer fault.

Solution:
Disconnect the switching device or external buffer and print with the printer directly connected to the comput-
er.
If you can then print normally, the fault is probably in the switching device or external buffer.  Consult the
hardware manufacturer.

Troubleshooting
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Cause:
Print spool is not operating correctly.

Solution:
Open the Printer Properties dialogue box directly from the Start menu.  Click on the Spool settings button in
the Details tab and then select "Print directly to the printer".

Cause:
Printer port LPT1: fault (when using the parallel interface only)

Solution:
Check the status of the printer port LPT1.
For details about checking the status of the printer port, refer to the Troubleshooting section of the Reference
Guide on the Setup Software & Reference Guide CD-ROM.

Cause:
Printer port set to LPT 1 using USB interface cable 

Solution:
Change the printer port to USB. Or, use a parallel interface cable after you have shut down Windows and
switched the printer off.
To change the printer port, open the Printer Properties dialogue box directly from the Start menu.  Click the
Details tab and then specify USBPRNnn (nn: numerals) in the "Print to the following port" box.

Cause:
Installed printer driver not operating correctly.

Solution:
Remove the installed BJ printer driver and then install the printer driver again.
To uninstall the printer driver, select Programs and then BJ Printer from the Windows Start menu and click
Uninstall.  Then follow the on-screen instructions.
When connecting to the USB interface running under Windows 98, refer to the “Additional Notes on Handling
the USB Interface” manual provided with the printer.

Cause:
WPS (Windows Printing System) driver is installed on the computer.

Solution:
Change the WPS driver port setting to FILE or delete the WPS driver.
To change the port setting, open the WPS Driver Properties window.  In the Details tab, select FILE in the
“Print to the following port” box.
To delete the WPS driver, select Programs and then Windows Printing System from the Windows Start menu
and click Uninstall. Then follow the on-screen instructions.
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● Application error or General Protection Fault printing does not execute

Cause:
Printing from a Windows 3.1 application program.

Solution:
Print from a Windows 98 or Windows 95 application program.

Cause:
Multiple software applications running.

Solution:
Quit all other application programs you are running and try printing again.

Cause:
Sufficient memory not available for the application program.

Solution:
Refer to the user's manual for your application program and check that the required amount of memory is
allocated to the application program.
If there is not enough memory installed, install more memory.  Refer to the user's manual for your computer
for information on installing additional memory.

Cause:
Sufficient space not available on hard disk.

Solution:
Delete any unneeded files to make more space available.

Cause:
Internal file or application program problem.

Solution:
Rebuild the document and print it again.  
If there is no problem with the new document, the original file was probably faulty.  If the same problem
recurs with the new file, contact a Canon service facility.

Cause:
Installed printer driver not operating correctly.

Solution:
Remove the installed BJ printer driver and then install the printer driver again.
To uninstall the printer driver select Programs and then BJ Printer from the Windows Start menu and click
Uninstall.  Then follow the on-screen instructions.
When connecting to the USB interface running under Windows 98, refer to the “Additional Notes on Handling
the USB Interface” manual provided with the printer.

Troubleshooting
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● Error number (*202) displayed
Cause:
Sufficient memory not available for the application program.

Solution:
Refer to the user's manual for your application program and check that the required amount of memory is
allocated to the application program.
If there is not enough memory installed, install more memory.  Refer to the user's manual for your computer
for information on installing additional memory.

● Error number (*203) displayed
Cause:
Installed printer driver not operating correctly.

Solution:
Load the Setup Software and Reference Guide CD-ROM.  When the CD-ROM folder opens, double-click the
BJ Installer icon and then select your printer.  Click the Custom Remove tab.  Then follow the on-screen
instructions.

● Error number (*300) displayed
Cause:
Printer is not on.

Solution:
Check the POWER lamp to see if it is lit green.
If the POWER lamp is flashing, the printer is still warming up.  Please wait until the POWER lamp is continu-
ously lit green.

Cause:
Printer cable not connected correctly.

Solution:
Make sure that the printer cable is securely fastened to the computer and the printer.
For details, refer to the Getting Started manual.

Cause:
Printer cable fault.

Solution:
Try using another printer cable.
For details about the printer cable, contact the hardware manufacturer.

Cause:
Switching device or external buffer fault.

Solution:
Disconnect the switching device or external buffer and print with the printer directly connected to the comput-
er.
If you can then print normally, the fault is probably in the switching device or external buffer.  Consult the
hardware manufacturer.

Cause:
Chooser may not be selected correctly.

Solution:
Select Chooser from the Apple menu.  Click on the BJC-3000 icon and check that BJC-3000 is selected in
Connect to box.
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Printing Stops in mid-job

Cause:
The print job is a finely detailed photograph or illustration.

Solution:
Check the POWER lamp.
If the POWER lamp is slowly flashing green, the printer is operating normally.  The printer requires more time
to process a finely detailed illustration or photograph.

Cause:
Printer has been operating for a long time.

Solution:
Interrupt printing at a convenient point, switch the printer off and wait for at least 15 minutes for the printer to
cool.
The print head may occasionally overheat during a long print job.  If the print head overheats, printing will
pause at the end of a pass across the page to allow time for the print head to cool and then will restart after
a brief interval.

To avoid minor burns, never touch the print head or the surrounding area.

Troubleshooting
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The POWER lamp flashes in orange

When an error occurs, the POWER lamp blinks for warning.  Count the
number of flashes and identify the problem as described below.

Flashes:
2

Cause:
Paper out, paper jam, paper feed error.

Solution:
Set the paper correctly.
If paper has jammed in the printer, remove the jam and press the RESUME button.

Flashes:
3

Cause:
Paper jam.

Solution:
If paper has jammed in the printer, remove the jam and press the RESUME button.

Flashes:
4

Cause:
BJ Cartridge out of ink.

Solution:
Replace the empty ink tank.

Flashes:
5

Cause:
BJ Cartridge not installed correctly.

Solution:
Install a BJ cartridge that is compatible with this printer.

Flashes:
6

Cause:
BJ Cartridge not installed.

Solution:
Install a BJ cartridge.

POWER lamp

RESUME button
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Flashes:
7

Cause:
BJ Cartridge defective.

Solution:
Remove each BJ Cartridge and check that the contacts on the BJ Cartridge and cartridge holder are clean.
Also check that the orange protective tape has been removed from the print head, then install the BJ
Cartridge again.

Flashes:
8

Cause:
Waste ink tank nearly full.

Solution:
Press the RESUME button to skip the error so you can continue printing.
When the waste ink tank becomes full, the POWER lamp flashes orange and green six times alternately, and
printing is no longer possible.  Contact a Canon service facility to have the waste ink tank replaced immedi-
ately.
The waste ink tank holds the ink used for print head cleaning. 

The POWER lamp flashes orenge and green alternately. 

Cause:
There may be a service error.

Solution:
Turn off the power once.  Then, turn the power on again.  If this does not clear the problem, contact your
Canon service facility.  Count the number of flashes. (You may be asked for this information.)

Troubleshooting
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Printout is unsatisfactory

● Meaningless characters or symbols printed

Cause:
Previous print job cancelled before it was finished.

Solution:
Switch off the printer and computer, switch them on again, and print again.

Cause:
Not using the correct printer driver. 

Solution:
Start the print procedure again and make sure BJC-3000 is displayed in the Name box of the Print dialogue
box.

Cause:
Printer cable not connected correctly.

Solution:
Check that the printer cable is securely fastened to the computer and the printer.
For details, refer to the Getting Started manual.

Cause:
Printer cable fault.

Solution:
Try using another printer cable.
For details about the printer cable, contact the hardware manufacturer.
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Cause:
Switching device or external buffer fault.

Solution:
Disconnect the switching device or external buffer and print with the printer directly connected to the comput-
er.  
If you can then print normally, the fault is probably in the switching device or external buffer. Consult the
hardware manufacturer.

Cause:
USB hub fault.

Solution:
Disconnect the USB hub you are using and then directly connect the printer to the computer.  If the printer
can print normally, the USB hub may not be operating properly.

Cause:
Printer is set to ECP mode.

Solution:
Disable ECP mode.
Open the Printer Properties dialogue box.  Click on the Maintenance tab and then click on the Custom
Setting button.  In the Custom Setting dialogue box, disable "Set printer to ECP mode" (if enabled) and click
on the Send button.

Cause:
Internal file or application software problem.

Solution:
Rebuild the document and print it again.  
If there is no problem with the new document, the original file was probably faulty.  If the same problem
recurs with the new file, contact a Canon service facility.

● Printout is faint or colours are wrong

Cause:
The print head nozzles in a BJ Cartridge are clogged or one of the inks has run out.

Solution:
Print a nozzle check pattern and check the status of the print head.

Cause:
Protective cap and tape have been re-attached to the BJ Cartridge.

Solution:
Remove the protective cap and tape. Install the BJ Cartridge again, and clean the print head.

Cause:
Not printing on correct side of the media

Solution:
Check that you load the media with the correct print side up.
For details about loading the media, refer to the Reference Guide on the Setup Software & Reference Guide
on the CD-ROM.

Troubleshooting
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● The last part of print job not printing

Cause:
The paper used for printing differs from the paper size specified in the application program and printer driver.

Solution:
- Specify the paper size you are using in the printer driver Page Size setting in the Page Layout tab.
- If your application program allows you to specify the paper size in the page setup, ensure that the Page
Size settings in the software application and the printer driver are the same.

Cause:
Printer cable not connected correctly.

Solution:
Check that the printer cable is securely fastened to the computer and the printer.
For details, refer to the Getting Started manual.

Cause:
Printer cable fault.

Solution:
Try using another printer cable.
For details about the printer cable, contact the hardware manufacturer.

Cause:
Switching device or external buffer fault.

Solution:
Disconnect the switching device or external buffer and print with the printer directly connected to the comput-
er.
If you can then print normally, the fault is probably in the switching device or external buffer. Consult the
hardware manufacturer.

Cause:
USB hub fault.

Solution:
Disconnect the USB hub you are using and then directly connect the printer to the computer.  If the printer
can print normally, the USB hub may not be operating properly.

Cause:
Printer is set to ECP mode. 

Solution:
Disable ECP mode.
Open the Printer Properties dialogue box.  Click on the Maintenance tab and then click on the Custom
Setting button.  In the Custom Setting dialogue box, disable "Set printer to ECP mode" (if enabled) and click
on the Send button.

Cause:
WPS (Windows Printing System) driver is installed on the computer.

Solution:
Change the WPS driver port setting to FILE or delete the WPS driver.
To change the port setting, open the WPS Driver Properties window.  In the Details tab, select FILE in the
“Print to the follwing port” box.
To delete the WPS driver, select Programs and then Windows Printing System from the Windows Start menu
and click Uninstall.  Then follow the on-screen instructions.
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● Print side rubbed and stained

Cause:
The Paper Thickness Lever is not positioned correctly.

Solution:
When you print data that consumes a large quantity of ink, the print side may be rubbing because it has a
tendency to curl, depending on the media you are using.  If this occurs, set the Paper Thickness Lever to the
Down position.
For details, refer to the Reference Guide CD-ROM.

● Printed and on-screen colour do not match

The colour reproduction methods used by monitors differ from those used by printers.  In addition, the printed
colour tones may not perfectly match those on the screen display because the colours vary depending on the
circumstances in which the display is viewed and the monitor's colour calibration settings.  For example,
objects that appear blue on the screen are printed purple, and objects that appear pale green on the screen
are printed dark green.  However, if the differences are extreme, the items below should be checked.

Cause:
The print head nozzles in a BJ Cartridge is clogged or one of the inks has run out.

Solution:
Print a nozzle check pattern and check the status of the print heads.

Cause:
The printer driver settings are not correct.

Solution:
To print a photo, select the correct print mode icon for the document you are printing (e.g., SuperPhoto).
Also check that the BJ Cartridge and Media Type settings match the BJ Cartridge and media you are using.

Troubleshooting



74

● Printed pages curled, warped or wrinkled

Cause:
You are printing on very thin paper and excess ink is being absorbed by the paper.

Solution:
Print on special print media made by applying a coating to the print side, such as High Resolution Paper or
Glossy Photo Paper.

Cause:
The print density is set too high.

Solution:
Reduce the print intensity in the printer driver.

To change this setting, open the Printer Properties dialogue box, click the Advanced button in the Main tab
and then click the Colour tab.  Move the Intensity slider to the left to lower the print intensity.

To change this setting, open the Printer Properties dialogue box, click the Manual icon and then click on the
Details button.  Select the Colour panel and move the Intensity slider to the left to lower the print intensity.



75

Other problems

Refer to the Reference Guide on the Setup Software & Reference Guide CD-ROM for information on
how to deal with the problems listed below.

● Colour document printed in monochrome
● Colours not clear
● Printed text rotated 90 degrees
● Printing in top left corner
● Text cut off at bottom right corner, right edge, or bottom edge
● Text or image reversed (mirrored)
● Enlarged/reduced printing not correct
● Single file page prints over two or more pages
● Straight lines are broken
● Backs of pages stained with ink
● Ink blurred
● Printed surface scratched
● White streaks visible
● Colours streaked or uneven
● Printer will not switch on
● Print job will not start
● Printing starts but nothing printing
● Cartridge holder does not move to left
● Envelopes do not feed
● Paper skewing during feeding
● Multiple sheets feed together
● Error messages other than "Error writing to LPT or USBPRN"
● "Application error" or "General Protection Fault" is displayed.
● BJ Status Monitor does not open
● Cannot execute background printing

Troubleshooting
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Specifications
Printing method:

Bubble Jet on-demand

Printing resolution:
1440 (horizontal) x 720 (vertical) dpi.

Print speed (printing with Canon standard pattern):
Colour printing using Color BJ Cartridge BC-33

Fast: 4 ppm
Normal:2.8 ppm

Photo colour printing using Color BJ Cartridge BC-34 Photo
Fine: 0.25 ppm

Black printing using Black BJ Cartridge BC-30
Fast: 9 ppm
Normal:6.8 ppm 

Print direction:
Bi-directional

Print width:
203 mm max. (7.99 in.)

Resident print control mode:
Canon extended mode

Receive buffer:
128 kB

Interface (parallel):
IEEE 1284-compatible

Interface (USB):
USB 1.0-compatible

Interface connector (parallel):
Amphenol 57-40360 or equivalent

Interface connector (USB):
USB standard Series B receptacle

Recommended printer cable (parallel):
Material: AWG28 or larger
Type: Twisted-pair shielded cable
Length: Up to 2.0m (6.5 ft)
Connectors: Amphenol 30360 or equivalent

Recommended printer cable (USB):
Material: AWG28 (data wiring pair) or AWG20 to 

28 (distribution pair)
Type: Twisted-pair shielded cable
Length: Up to 5.0m (16.4 ft)
Connectors: USB standard Series B pluggable

Acoustic noise level:
Approx. 45 dB (per ISO 9296)

Operating environment:
Temperature: 5°C to 35°C (41°F to 95°F)
Humidity: 10% to 90%RH (no condensation)

Storage environment:
Temperature: 0°C to 35°C (32°F to 95°F)
Humidity: 5% to 90%RH (no condensation)

Power supply:
Europe AC 230V±10%, 50Hz
USA/Canada AC 120V, 60Hz
Australia AC 240V, 50Hz

Power consumption:
off*: Approx. 2W (AC 230±10%)

Approx. 2W (AC 120V)
Standby**: Approx. 3W (AC 230±10%)

Approx. 3W (AC 120V)
Printing: Approx. 35 W

*: To shut down power completely, remove the power cord from the
wall outlet. 

**: This printer is provided with an automatic power off feature.  If
the printer does not receive any data for a specified length of
time, the printer automatically powers down to the standby mode.
You can set the printer to power down automatically if it does not
receive a print job for 1, 10, 30 or 60 minutes.
For details about switching on the Auto Power Off feature and
setting the time interval to elapse before powering down to stand-
by, refer to on-line Help.

Dimensions (with paper rest and paper output tray retracted):
418 mm(W) x 306 mm(D) x 169 mm (H)
16.5"(W) x 12.0"(D) x 6.7"(H)

Weight:
Approx. 3.7 kg (8.16 lb.)

Feed method:
Continuous feed through auto sheet feeder

For High resolution paper, plain paper, envelopes,
Transparencies, Glossy photo paper, 
gloss photo film, Back print film, Glossy photo cards, 
T-shirt transfers

Sheet feeder capacity:
Plain paper (64 g/m2) 100 sheets max.
High resolution paper 80 sheets max.
Envelopes 10 pieces max.
Transparencies 30 sheets max.
Back print film 10 sheets max.
Glossy photo paper 10 sheets max.
High gloss photo film 1 sheet
Glossy photo cards 1 sheet
Banner paper 1 sheet
T-shirt transfers 1 sheet
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Ordinary print media:
Regular size: A4, A5, B5, Letter, Legal, European DL,

US Com.#10
Custom size:

width: 100.0mm to 241.3mm (3.94" to 9.50")
height: 100.0mm to 584.2mm (3.94" to 23.0")

Weight: 64 to 105 g/m2

Special Canon media:
Bubble Jet paper LC-301
High Resolution Paper HR-101S
Glossy Photo Paper GP-301
High Gloss Photo Film HG-201
Glossy Photo Cards FM-101
Transparencies CF-102
Back Print Film BF-102
T-Shirt Transfers TR-201
Banner Paper

Graphic image printing:
Data format:

Canon extended mode: Raster image format
Resolution:

Canon extended mode: 180, 360, 720, 1440 dpi

Compatible BJ Cartridges:
Color BJ Cartridge BC-33:

Nozzles: 48 per colour
Ink colours: Black, Cyan, Yellow, Magenta
Capacity*: Approx. 280 sheets 

(at 7.5% coverage per colour)
*: Based on the number of sheets per ink tank over the printable

area on A4-size plain paper.

Color BJ Cartridge BC-34 Photo:
Nozzles: 48 per color
Ink colours: Yellow, Photo Black, Photo Cyan, 

Photo Magenta
Capacity*: Approx. 280 sheets 

(at 7.5% coverage per colour)
*: Based on the number of sheets per ink tank over the printable

area on A4-size plain paper.

Black BJ Cartridge BC-30:
Nozzles: 160
Ink colours: Black only
Capacity: Approx. 500 sheets

(1500 characters per page, normal text)

Printer driver operating environment:
IBM PC/AT-compatible computer running Windows 98,
Windows 95, Windows NT 4.0, or iMac or Power
Macintosh G3 computer running Mac OS 8.1 or later

Hard disk space:
Approx. 29MB to install on Windows 98, Windows 95,
Windows NT 4.0, or approx. 21MB to install on Mac OS
(including temporary files)

• BJ Status Monitor cannot be used when printer is used in
network operating environment.

• When connecting printer and computer through USB inter-
face, use the system under the following operating environ-
ment.

Computer with Microsoft Windows 98, which is
preinstalled by a computer manufacturer on pur-
chase. (USB port operation also needs to be
assured by the manufacturer.)

iMac or Power Macintosh G3 computer with USB
interface with Mac OS 8.1 or later, which is prein-
stalled by a computer manufacturer on purchase.
(When using an iMac running under Mac OS 8.1,
the system must be upgraded using iMac
Firmware 1.0, which can be downloaded from the
home page of Apple Computer, Inc.)

Specifications are subject to change without notice.

Specifications
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